NRF52833 DK

v1.0.0

User Guide

N

NORDIC

SEMICONDUCTOR

4452_198 / 2020-12-03



Contents

Revision history. . . . . . . . . . . v
1 Introduction. . .. ... ... .. ... ... .. ... . ... ... .. ...5
2 Minimum requirements. . . . . . . . . . .. . . .. ... ... ... b
3 Kitcontent. . . . ...
4  Getting started. .~ . .. ... ... .. .. .. ... 8
5 Nordic tools and downloads. . . . . . . ... ... ... ... ... ..9
6 Start developing. . .~ . . . . ... .12

7 Interface MCU. . .~ . . . . . ... ... ... .. ... 13

7.1 IF Boot/Reset button . . . . . . . 13
7.2 Virtual COM port . . . . . . . . . .13
7.3 MSD . . 14

8 Hardware description. . . . . . . . ... ... .. . .. .15

8.1 Hardware drawings . . . . . . . . . . . . . . . . . . . . . . . . . . .. ... 15
8.2 Block diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . ... ... 15
83 Power supply . . . . . . . . . . . . . . . . . . . ... ... .. ........16
8.3.1 5V power sources . . . . . . . . ..o
8.3.2 VDD power sources . . . . . . . ...
8.3.3 Interface MCU power . . . . . . . . . . . . . . . . . . . . . . ...... 20
8.3.4 nRF52833 power source . . . . . . . . . . . . . ... ... .21
8.3.5 nRF52833 SoC direct supply . . . . . . . . . . . . . . . . . . . .. . ... 22
8.4 Operating modes . . . . . . . . . . . . . . . . . . . . . . . .. ... ....... 23
8.4.1 USB detect . . . . . .28
8.4.2 Firmware development mode 28
8.4.3 Signal switches . . . . . . . . . . . . . . . . . . . . . . . . . .. .... 24
8.5 Connector interface . . . . . . . . . . . . . . . . . . . . . . . . . .. .... 26
8.5.1 Mapping of analog pins . . . . . . . . . . 28
8.6 Buttonsand LEDs . . . . . . . . . . . . . . . . . . . . . . . . . . .. .... 28
8.7 32.768 kHz crystal . . . . . . . . . . . . . . . . . . . . . . . . . .. .....30
8.8 Debug inputandtrace. . . . . . . . . . . . . . . . . . . . . . . . . ..... 13
8.9 Debug output . . . . . - ¥ |
8.10 Connectors for programming extemal boards - 7
8.11 NFC antenna interface . . . . . . . . . . . . . . . . . . . . . . . . . . ... 133
8.12 Extra op-amp . . . - 4
8.13 Solder bridge conflgurat|on .. ........... 3

9 Measuring current. . . . .37

9.1 Preparing the DK . . . . . - V4
9.2 Using an oscilloscope for current proﬂle measurement. . . . . . . . . . . . . . . . 38
9.3 Using an ampere meter for current measurement. . . . . . . . . . . . . . . . . . 39

N

NORDIC"

SEMICONDUCTOR

4452 198 i



10 RF measurements. . . . . . . 40

Glossary . . . . . . e 41
Acronyms and abbreviations. . . . . . . . .. . L 43
Recommended reading. . . . . . . . . . . L 44
Legal notices. . . . . . . . . 45

N

NORDIC"

SEMICONDUCTOR

4452 198 iii



Revision history

2020-12-03 Editorial changes

April 2020 Editorial changes

October 2019 First release (for nRF52833 DK v0.9.0 and 1.0.0)

4452 198 iv .

NORDIC

SEMICONDUCTOR



1 Introduction

The nRF52833 DK is a hardware development platform used to design and develop application firmware
on the nRF52833 System on Chip (SoC).

This kit can be used for developing for either the nRF52833 and nRF52820 SoCs.
The key features of the Development Kit (DK) are:

e nRF52833 flash-based Bluetooth® Low Energy, Thread, Zighee, ANTTM/ANT+TM SoC solution
e Support for nRF52833 and nRF52820 SoCs development

e Buttons and LEDs for user interaction

¢ 1/0 interface for Arduino form factor plug-in modules

e SEGGER J-Link OB Debugger with debug out functionality

¢ UART interface through virtual COM port

e USB

e Drag-and-drop Mass Storage Device (MSD) programming

e Support for NFC-A Listen Mode

For access to firmware source code, hardware schematics, and layout files, see www.nordicsemi.com.

Environmental Protection
Waste electrical products should not be disposed of with household waste.

Please recycle where facilities exist. Check with your local authority or
retailer for recycling advice.
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https://www.nordicsemi.com

Minimum requirements

Before you start, check that you have the required hardware and software.

Hardware requirements

e Personal computer (PC) or Mac
¢  Micro-USB 2.0 cable

Software requirements

e SEGGER J-Link Software v6.52 or later

~

NORDIC"

SEMICONDUCTOR

4452 198 6



3 Kit content

The nRF52833 DK includes hardware, preprogrammed firmware, documentation, hardware schematics,
and layout files.

The nRF52833 DK (PCA10100) comes with a Near Field Communication (NFC) antenna.

PCA10160
B |
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start52833dk
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Figure 1: nRF52833 DK (PCA10100) and NFC antenna

Hardware files

The hardware design files including schematics, PCB layout files, bill of materials, and Gerber files for the
nRF52833 DK are available on the nRF52833 product page.
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https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52833

A Getting started

To get started with the nRF52833 DK, go to nRF52833 DK Getting Started and follow the instructions there.
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https://www.nordicsemi.com/Software-and-Tools/Development-Kits/nRF52833-DK/GetStarted#infotabs

5 Nordic tools and downloads

Once you have your kit set up you can start developing. Our software tools help you develop and test your
device through all the steps in the software development cycle.

Development IDE

Pick one of the IDEs with a compiler supported by Nordic:

Studio (SES)

SEGGER Embedded

MDK-ARM Keil uVision | Yes No No
GNU/GCC Yes Yes Yes
IAR Yes No No

SES is the recommended platform. It is free for use with nRF devices.

Essential tools

You need to download these Nordic tools to develop with our devices.

Application Windows/Linux nRF5 SDK v17.0.2 BLE/ANT
(Software examples, source
Development | files, SoftDevices nRFS SDK for Mesh Bluetooth
Kit) v5.0.0 Mesh
nRF5 SDK for Thread | Thread and
and Zigbee v4.1.0 Zigbee
nRF Collection of nRF Command Line Tools | "RF Command Line BLE/ANT
Command command line Tools
Line Tools tools, like nrfjprog,
mergehex

Optional tools

These tools are not essential, but we recommend that you use them.

4452_198
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https://www.segger.com/products/development-tools/embedded-studio/
https://www.segger.com/products/development-tools/embedded-studio/
https://www2.keil.com/mdk5/uvision/
https://gcc.gnu.org/
https://www.iar.com/iar-embedded-workbench/#!?architecture=ARM
https://developer.nordicsemi.com/
https://infocenter.nordicsemi.com/topic/struct_sdk/struct/sdk_nrf5_latest.html
https://infocenter.nordicsemi.com/topic/struct_sdk/struct/sdk_mesh_latest.html
https://infocenter.nordicsemi.com/topic/struct_sdk/struct/sdk_mesh_latest.html
https://infocenter.nordicsemi.com/topic/struct_sdk/struct/sdk_thread_zigbee_latest.html
https://infocenter.nordicsemi.com/topic/struct_sdk/struct/sdk_thread_zigbee_latest.html
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Command-Line-Tools/Download#infotabs
https://infocenter.nordicsemi.com/topic/ug_nrf_cltools/UG/cltools/nrf_command_line_tools_lpage.html
https://infocenter.nordicsemi.com/topic/ug_nrf_cltools/UG/cltools/nrf_command_line_tools_lpage.html

Nordic tools and downloads

Tool

SoftDevice

Description

Wireless protocol
stack

Download

Compatible downloads
for nRF52840

Compatible downloads
for nRF52833

Compatible downloads
for nRF52832

Compatible downloads
for nRF52811

Compatible downloads
for nRF52810

Compatible downloads
for nRF51822

Compatible downloads
for nRF51422

Documentation
nRF51 SoftDevice
Specifications

nRF52 SoftDevice
Specifications

Protocol

BLE/ANT

nRF Connect for
Desktop

Expandable desktop
tool with several apps,
including:

e Peer device
emulator

e Power Profiler
e Programmer
¢ Cloud Gateway

nRF Connect for
Desktop

nRF Connect
Bluetooth Low Energy

BLE

nRF Connect for Peer device emulator | Android v4.3 or later BLE
Mobile app for smartphones
I0S v8 or later
Nordic nRF Toolbox | App that contains all | Android v4.3 or later BLE
app the Nordic apps
10S v8 or later
Windows Phone v8.1
or later
nRF pynrfjprog Simple Python nRF pynrfjprog nRF pynrfjprog BLE/ANT
interface for the
nrfjprog DLL
ANTware Il Peer device emulator  ANTware 11 ANT
for the ANT protocol
running on computers
nRF Sniffer App for monitoring on- | nRF Sniffer download | nRF Sniffer for BLE
air traffic Bluetooth LE
nRF Thread Topology | Tool for visualizing nRF Thread Topology nRF Thread Topology | Thread
Monitor Thread mesh network | \1onitor Monitor
topology in real time
Thread Border Gateway for Thread Border Router | Thread Border Router | Thread

Router

4452198
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https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52840/Compatible-downloads#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52840/Compatible-downloads#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52833/Downloads#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52833/Downloads#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52832/Download#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52832/Download#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52811/Download#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52811/Download#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52810/Download#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF52810/Download#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF51822/Download#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF51822/Download#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF51422/Compatible-downloads#infotabs
https://www.nordicsemi.com/Products/Low-power-short-range-wireless/nRF51422/Compatible-downloads#infotabs
https://infocenter.nordicsemi.com/topic/struct_nrf51/struct/nrf51_softdevices.html
https://infocenter.nordicsemi.com/topic/struct_nrf51/struct/nrf51_softdevices.html
https://infocenter.nordicsemi.com/topic/struct_nrf52/struct/nrf52_softdevices.html
https://infocenter.nordicsemi.com/topic/struct_nrf52/struct/nrf52_softdevices.html
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Connect-for-desktop
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Connect-for-desktop
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Connect-for-desktop/Download#infotabs
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Connect-for-desktop/Download#infotabs
https://infocenter.nordicsemi.com/topic/ug_nrfconnect_ble/UG/nRF_Connect_BLE/nRF_Connect_intro.html
https://infocenter.nordicsemi.com/topic/ug_nrfconnect_ble/UG/nRF_Connect_BLE/nRF_Connect_intro.html
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Connect-for-mobile
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Connect-for-mobile
https://play.google.com/store/apps/details?id=no.nordicsemi.android.mcp
https://apps.apple.com/us/app/nrf-connect/id1054362403
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Toolbox
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Toolbox
https://play.google.com/store/apps/details?id=no.nordicsemi.android.nrftoolbox&hl=en
https://apps.apple.com/us/app/nrf-toolbox/id820906058?mt=8
https://github.com/NordicPlayground/Windows-nRF-Toolbox
https://github.com/NordicPlayground/Windows-nRF-Toolbox
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-pynRFjprog/Download#infotabs
https://infocenter.nordicsemi.com/topic/ug_pynrfjprog/UG/pynrfjprog/pynrfjprog_lpage.html
https://www.thisisant.com/
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Sniffer-for-Bluetooth-LE/
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Sniffer-for-Bluetooth-LE/Download#infotabs
https://infocenter.nordicsemi.com/topic/ug_sniffer_ble/UG/sniffer_ble/intro.html
https://infocenter.nordicsemi.com/topic/ug_sniffer_ble/UG/sniffer_ble/intro.html
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Thread-topology-monitor
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Thread-topology-monitor
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Thread-topology-monitor/Download#infotabs
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Thread-topology-monitor/Download#infotabs
https://infocenter.nordicsemi.com/topic/sdk_tz_v4.1.0/thread_topology_monitor.html
https://infocenter.nordicsemi.com/topic/sdk_tz_v4.1.0/thread_topology_monitor.html
https://www.nordicsemi.com/Software-and-Tools/Software/nRF5-SDK-for-Thread-and-Zigbee/Download#infotabs
https://infocenter.nordicsemi.com/topic/sdk_tz_v4.1.0/thread_border_router.html

Nordic tools and downloads

network to the
Internet

See also Nordic mobile apps for a list of available Bluetooth Low Energy and Mesh mobile apps for iOS,
Android, and Windows Phones.
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https://www.nordicsemi.com/Software-and-Tools/Development-Tools/Mobile-Apps

Start developing

After you have set up the DK and installed the toolchain, it is time to start developing.
There are several ways to continue from here, depending on which networking protocol you want to use.

e For nRF5 SDK for Bluetooth Low Energy, ANT, or proprietary 2.4Ghz (nRF5 Series devices), see nRF5
SDK Getting Started.

* For nRF5 SDK for Mesh (nRF5 Series devices), see Getting Started with Mesh.

e For nRF5 SDK for Thread and Zigbee, see Getting Started with Thread and Zigbee.

See also Software development Getting Started Guides for guidance for the main Integrated Development
Environment (IDE)s .
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https://infocenter.nordicsemi.com/topic/sdk_nrf5_v17.0.2/nrf51_getting_started.html
https://infocenter.nordicsemi.com/topic/sdk_nrf5_v17.0.2/nrf51_getting_started.html
https://infocenter.nordicsemi.com/topic/com.nordic.infocenter.meshsdk.v5.0.0/md_doc_getting_started_getting_started.html
https://infocenter.nordicsemi.com/topic/sdk_tz_v4.1.0/thread_zigbee__intro.html
https://infocenter.nordicsemi.com/topic/struct_nrf5gs/struct/nrf5gs_sw_dev.html

/ Interface MCU

The interface MCU on the nRF52833 DK runs SEGGER J-Link OB interface firmware and is used to program
and debug the firmware of the nRF52833 SoC.
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Figure 2: Interface MCU

7.1 IF Boot/Reset button

The nRF52833 DK is equipped with an IF Boot/Reset button (SW5).
This button is connected to the interface MCU on the DK and has two functions:

e Resetting the nRF52833 SoC.
¢ Entering bootloader mode of the interface MCU.

During normal operation the button will function as a reset button for the nRF52833 SoC. For this to work,
pin reset on P0.18 needs to be enabled in the SoC.

The button is also used to enter the bootloader mode of the interface MCU. To enter the bootloader
mode, keep the reset button pressed while powering up the DK until LED5 starts to blink. You can power
up the DK either by disconnecting and reconnecting the USB cable or by toggling the power switch (SW8).

Note: Pin reset can be enabled by adding the CONFIG_GPIO_AS_PINRESET variable to the compiler
preprocessor macros. The way of doing this depends on the IDE/toolchain in use:

¢ When using SEGGER Embedded Studio, go to Project > Edit Options > Code > Preprocessor >
Preprocessor Definitions and add the CONFIG_GPIO_AS_PINRESET variable.

e When using Keil, go to Project > Options for Target > C/C++ > Preprocessor Symbols > Define
and add the CONFIG_GPIO_AS_PINRESET variable.

If your program does not enable pin reset, this functionality can also be enabled on an already

programmed device by calling nrfjprog.exe with argument ——pinresetenable. To disable
pinreset again, reprogram with ——chiperase.

7.2 Virtual COM port

The onboard interface MCU features a Universal Asynchronous Receiver/Transmitter (UART) interface
through a virtual COM port.

4452 198 13 >
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Interface MCU

The virtual COM port has the following features:

Flexible baud rate setting up to 1 Mbps.1
¢ Dynamic Hardware Flow Control (HWFC) handling.
e Tri-stated UART lines when no terminal is connected.

The following table shows an overview of the UART connections on nRF52833 SoC and the interface MCU.

GPIO nRF52833 nRF52833 UART
P0.05 RTS
P0.06 TXD
P0.07 CTS
P0.08 RXD

Table 1: Relationship of UART connections on nRF52833 and interface MICU

The UART signals are routed directly to the interface MCU. The UART pins connected to the interface MCU
are tri-stated when no terminal is connected to the virtual COM port on the computer.

Note: The terminal software used must send a Data Terminal Ready (DTR) signal to configure the
UART interface MCU pins.

The P0.05 (Request to Send (RTS)) and P0.07 (Clear to Send (CTS)) can be used freely when HWFC is
disabled on the SoC.

7.3 MSD

The interface MCU features an MSD. This makes the DK appear as an external drive on your computer.

This drive can be used for drag-and-drop programming. However, files cannot be stored on this drive. By
copying a HEX file to the drive, the interface MCU will program the file to the device.

Note:

¢ Windows might try to defragment the MSD part of the interface MCU. If this happens, the
interface MCU will disconnect and be unresponsive. To return to normal operation, the DK must
be power cycled.

¢ Your antivirus software might try to scan the MSD part of the interface MCU. Some antivirus
programs trigger a false positive alert in one of the files and quarantine the unit. If this happens,
the interface MCU will become unresponsive.

e If the computer is set up to boot from USB, it can try to boot from the DK if the DK is connected
during boot. This can be avoided by unplugging the DK before a computer restart, or changing
the boot sequence of the computer.

You can also disable the MSD of the kit by using the msddisable command in J-Link Commander. To
enable, use the msdenable command. These commands take effect after a power cycle of the DK and
stay this way until changed again.

! Baud rate 921 600 is not supported through the virtual COM port.
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8 Hardware description

The nRF52833 DK (PCA10100) can be used as a development platform for the nRF52833 SoC. It features an

onboard programming and debugging solution.

In addition to radio communication, the SoC can communicate with a computer through USB and a virtual

COM port provided by the interface MCU.

8.1 Hardware drawings

nRF52833 DK hardware drawings show both sides of the PCA10100.
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Figure 3: nRF52833 DK (PCA10100) front view
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Figure 4: nRF52833 DK (PCA10100) back view

8.2 Block diagram

The nRF52833 DK block diagram shows the connections between the different blocks.
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Figure 5: Block diagram

The nRF52833 DK has multiple power options.

The power options are the following:

e USB connector J2 for the interface MCU (5 V)
e USB connector J3 for the nRF52833 SoC (5 V)
o Lithium polymer (Li-Po) battery connectors J6 or P27 (2.5-5.0 V)
¢ VIN 3-5 pin on P20 (3.0-5.0 V)
e External supply on P21 (1.7-3.6 V)
e Coin cell battery
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Figure 7: Power supply options (back)

8.3.1 5V power sources
The nRF52833 DK has a 5 V boost regulator.

It gives a stable 5 V output from the following sources:

e USB connector J2 for the interface MCU

e USB connector J3 for the nRF52833 SoC

¢ Li-Po polymer battery connectors (J6 or P27)
e VIN 3-5V pin on P20

Each source has a reverse protection diode to prevent current flowing in the wrong direction if multiple
sources are connected at the same time.

VBOOST SRC' VBOOST SRC ul12
D80 CEN T 1
VBUS|—>f}——9 ° BAT VOUT
NSR0620P2T5G L L80
D8l 1ouF| (M
VBUS nRF—4}——9 " 1 LX FB
NSR0620P2T5G 4 EN CDD
D32 =~ MODE PGND
VLi-lonf—>}—— —— FO  AGND
g%zoezopnsc XCOI31
VIN3-5Vp—>f}—— = =
NSR0620P2T5G

Figure 8: 5 V regulator and protecting diodes

8.3.2 VDD power sources

The main supply (VDD) can be sourced from the 5 V domain, external power supply, and coin cell battery.

For the 5V domain, there are two regulators, one fixed 3 V buck regulator and one voltage follower
regulator that follows the VDD_nRF voltage. The coin cell battery and external power supply are not
regulated.

e 5V domain:

¢ Fixed 3 V buck regulator

e VDD_nRF voltage follower
e External power supply
e Coin cell battery

For more information about power sources, see nRF52833 power source on page 21.

The power sources are routed through a set of load switches, which is controlled by logic to prioritize the
power sources in the correct manner.
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If the high voltage regulator of the nRF52833 is used, the DK will be supplied from the VDD_nRF voltage
follower regardless of the state of the other power sources.
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Figure 9: Power supply circuitry
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The power switches work in the way that the body diode of the internal transistor powers the VSUPPLY
net, which supplies the gates controlling the enable signal of the switches. If 5 V is present, the switches
for external supply and battery are disabled. If external supply is present, the switch for the battery is
disabled.

The power switches can be bypassed by shorting one or more solder bridges.

Power source Power switch bypass Voltage level
Regulator SB34 3.0V
External supply SB36 1.7V-3.6V

Table 2: Power switch bypass solder bridges
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Figure 10: Power switch bypass solder bridges

Note: Connect only one power source at a time. Shorting the solder bridges removes the reverse
voltage protection.

8.3.3 Interface MCU power

The power for the interface MCU is routed through two load switches, one for the VDD supply and one for
the USB supply. This makes it possible to disconnect the interface MCU from the power domain when not
in use.
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Figure 11: Interface MCU power switch

These switches are controlled by the presence of a USB connected to the interface MCU USB connector

(J2), and the state of the nRF only switch (SW6). See Operating modes on page 23 for more

information.

8.3.4 nRF52833 power source

The nRF52833 DK has a power source switch (SW9) for selecting between three power sources for the

nRF52833 SoC.

The three positions of the switch are the following:

e VDD (default)
e Li-Po
e USB
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The nRF52833 SoC has a high voltage buck regulator that can support up to 5 V input. In the VDD position,
the SoC is powered either from the onboard buck regulator, coin cell battery, or external supply (P21).
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In the Li-Po position, the high voltage regulator of the SoC is supplied directly from the Li-Po battery
connectors (J6 or P27). In the USB position, the USB high voltage regulator gets power from the nRF52833
USB connector (J3).

When the high voltage regulator is used, the VDD_nRF voltage can be set by the firmware of the SoC.
To make sure the rest of the DK has the same voltage level, the VDD of the DK is sourced by a regulator
following the VDD_nRF voltage when the high voltage regulator is used.

| ?185 VsV Q80 FCXG90BTA  TP34 U16 VSENSE SW_OUT
-I|| i1 s > VOUT VIN
100nF
VIQ REF VDD_nRE_SENSE GND BN
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R99
L
10k 5869
VSUPPLY ul17
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RS87
MOsuppLy BN
EN GND |/
i ey 252 SC728CSTRT =
Res I~ RV2C010UNT2L =

10M

Figure 13: VDD_nRF voltage follower and switch

To make sure that the nRF52833 SoC is not powered when the nRF power switch (SW8) is OFF, two load
switches are used, one for the high voltage regulator (U23) and one for the USB supply (U22). These
switches are controlled by VDD.

8.3.5 nRF52833 SoC direct supply

It is possible to power the SoC directly from a source without powering the rest of the DK from the same
source.

This is done by connecting the external source to the external supply connector (P21) and sliding the
VEXT->nRF switch (SW10) to the ON position. The nRF power source switch (SW9) must be in the VDD
position, and the allowed voltage range is 1.7-3.6 V.
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Since it is only the nRF52833 SoC that is supplied from this source, it is recommended that the VDD
domain is supplied from a different source to prevent the pins of the SoC to be connected to unpowered
devices.
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To avoid voltage differences on the DK, the External supply is also connected to the input of the voltage
follower when the VEXT->nRF switch (SW10) is in the ON position. The voltage follower circuit requires 5 V
to be present on the DK, see 5 V power sources on page 17.

The voltage follower can be disconnected from the External supply by cutting SB58. To prevent leakage
due to voltage differences, the DK should be set in the nRF only mode, see Firmware development mode
on page 23.

8.4 Operating modes

The nRF52833 DK has various modes of operation.

8.4.1 USB detect

To detect when USB for the interface MCU is connected, there is a circuit sensing the VBUS of USB
connector J2.

When the USB cable is connected, the VDD is propagated to the USB_DETECT signal.

SB31
VDD

) . USB DETECT
3 R26
Q40B 47k

PMCPB5530

VBUS
1 Q40A
Ra0 ] PMCPB5530
150k

Figure 15: USB detect

8.4.2 Firmware development mode
The firmware development mode is active with the nRF ONLY switch (SW6) in the DEFAULT position.

The nRF only mode disconnects the power supply and LEDs of the interface MCU. It also disconnects the
signal lines between the nRF52833 SoC and the interface MCU using analog switches.

This is done to isolate the chip on the DK as much as possible, and can be of use when measuring currents
on low-power applications.
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8.4.3 Signal switches

On the nRF52833 DK, there are multiple analog switches that are used to connect and disconnect signals

based on different scenarios.
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Figure 17: Signal switches

The USB and SW6 control the signal switches by using USB_DETECT as an input to SW6. Therefore, the
interface MCU can be disconnected either by unplugging the USB cable from J2 or by toggling the nRF
ONLY switch SW6.

The signal controls a set of switches (U5, U6, U7) that break the connection between the nRF52833 and
the interface MCU, and control the power for the interface MCU. For more information, see Interface MCU
power on page 20.

Switches U5 and U6 break the connection of the UART lines and SWD/RESET lines. In addition, the
signal controls the routing of the RESET signal depending on user preference when the interface MCU is
connected/disconnected.

e When the interface MCU is disconnected, cutting SB42 will disconnect the IF BOOT/RESET button
(SW5) from the reset pin (P0.18) of nRF52833.
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¢ When the interface MCU is disconnected, shorting SB45 will connect the RESET pin in the Arduino
interface to the reset pin (P0.18) of nRF52833.

¢ When the interface MCU is connected, shorting SB46 will connect the RESET pin in the Arduino
interface to the BOOT input of the interface MCU.

¢ Shorting SB43 will connect the RESET pin in the Arduino interface to the IF Boot/Reset button.
¢ Shorting SB44 will connect the RESET pin in the Arduino interface to the reset pin (P0.18) of nRF52833.

When a shield is connected, there are two analog switches connecting the pull-up resistors to the 12C bus
lines (SDA and SCL). This function is using one ground pin on the Arduino shield to control the switch. This
feature can be disabled by cutting SB33. To permanently enable pull-up resistors, short SB32.

OO [606 0066 O<—GeND nRFONYDEFAUT 0012 o)

000F 00000000k i

Fow— oV —— ]

N EEEEEEEL @) LED1 LED2 Psee 22

LT 0 T T U U R dm @p eos2 Lo = Eg

222 53353883 s¢ d b LED3 LED4 &

aai EEEEREER g £ P03 qE @p Pote 23 B & M
nRF current oo H P0.15 @ @ p PO.16 14
measurement o5 2 Alt._Def. po18 @ @ PO2icril B =

88 2 SB60CD 00 |2 ro2s q@ @P mum‘s%sé;

%5 &

35

o

es

o

Po22 d 8
g roz
& reseT

mo]

SB32

Debuging

External supply

53 horoic

5 @ ses
P21 + Ssaa9 * %) 5855 oo S%ﬂ s851 ®sess

0 L\-po?@ﬂ sy o & osos g DB q 'n q b

& 5 A tOE YO R
[ £ ssfs.g9s48288850 ® & I R x
< $88c:583 8¢ T
2=2°9 il ;
R Butt Button 4 b
" sQOvexpre, BB B EE B EXEE] IF BOOTRESET  nRF USB Bution3  Button 4 bd g
g i e Zor @°° A OETOE— &
& ; [coco00O 000k d i g i g
ON_ OFF ofFon [I000 006 © © ©[c=cND — x

Figure 18: Solder bridges: Shield detect and reset behavior

SB33
SB42

—— SB43

SB44
SB45
SB46

The last switch (U8) controls which GPIOs certain signals are routed to. This is due to some features using
the same GPIOs as the Trace output by default. These analog switches are controlled by SW7. See Debug
input and trace on page 30 for more information.

8.5 Connector interface

Access to the nRF52833 GPIOs is available from connectors P2, P3, P4, P5, P6, and P24.

The P1 connector provides access to ground and power on the nRF52833 DK.
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Figure 19: nRF52833 DK connectors

P4

P3

P6

P24

Some of the signals are also available on connectors P7, P8, P9, P10, P11, and P12, which are on the
bottom side of the DK. By mounting pin lists on the connector footprints, the nRF52833 DK can be used as

a shield for Arduino motherboards? or other boards that follow the Arduino standard.

For easy access to GPIO, power, and ground, the signals can also be found on the through-hole connectors
P13-P17.

Note:

Some pins have default settings:

P0.00 and P0.01 are used for the 32.768 kHz crystal and are not available on the connectors. For
more information, see 32.768 kHz crystal on page 30.
P0.05, P0.06, P0.07, and P0.08 are used by the UART connected to the interface MCU. For more
information, see Virtual COM port on page 13.
P0.09 and P0.10 are by default used by NFC1 and NFC2. For more information, see NFC antenna

interface on page 33.

P0.11-P0.16 and P0.24—P0.25 are by default connected to the buttons and LEDs. For more
information, see Buttons and LEDs on page 28.

When the nRF52833 DK is used as a shield together with an Arduino standard motherboard, the Arduino
signals are routed as shown in the following figure.

2 Only 3.3 V Arduino boards.
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Figure 20: Arduino signals routing on the nRF52833 DK

8.5.1 Mapping of analog pins

The table shows the mapping between GPIO pins, analog inputs, and the corresponding Arduino analog
input naming.

P0.03 AIN1 A0
P0.04 AIN2 Al
P0.28 AIN4 A2
P0.29 AIN5 A3
P0.30 AING6 A4
P0.31 AIN7 A5

Table 3: Mapping of analog pins

8.6 Buttons and LEDs

The four buttons and four LEDs on the nRF52833 DK are connected to dedicated GPIOs on the nRF52833
SoC.
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Part GPIO GPIO alternative Solder bridge
Button 1 PO.11 P1.07 -

Button 2 P0.12 P1.08 -

Button 3 P0.24 -

Button 4 P0.25 -

LED 1 PO.13 SB5

LED 2 P0.14 SB6

LED 3 P0.15 SB7

LED 4 PO.16 SB8

Table 4: Button and LED connection

If P0.13—-P0.16 are needed elsewhere, the LEDs can be disconnected by cutting the short on SB5-SB8. See
Figure 21: Disconnecting the LEDs on page 29 for more information.

Since P0.11 and PO. 12 are used as part of the Trace functionality, Button 1 and Button 2 can be moved
to alternative GPIOs. See Debug input and trace on page 30 for more information.
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Figure 21: Disconnecting the LEDs

The buttons are active low, meaning that the input will be connected to ground when the button is
activated. The buttons have no external pull-up resistor, and therefore, to use the buttons, the P0.11,
P0.12, P0.24, and P0.25 pins must be configured as input with an internal pull-up resistor.

The LEDs are active low, meaning that writing a logical zero (0) to the output pin will illuminate the LED.
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Figure 22: Button and LED configuration
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Hardware description

8.7 32.768 kHz crystal

The nRF52833 SoC can use an optional 32.768 kHz crystal (X2) for higher accuracy and lower average

power consumption.

On the nRF52833 DK, P0.00 and P0.01 are used for the 32.768 kHz crystal by default and are not available

as GPIO on the connectors.

Note: When using ANT/ANT+, the 32.768 kHz crystal (X2) is required for correct operation.

If P0.00 and P0.01 are needed as normal 1/Os, the 32.768 kHz crystal can be disconnected and the
GPIO routed to the connectors. Cut the shorting track on SB1 and SB2, and solder SB3 and SB4. See the

following figure for reference.
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Figure 23: Configuring P0.00 and P0.01
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Figure 24: 32.768 kHz crystal and SB1-SB4

8.8 Debug input and trace

The Debug in connector (P18) makes it possible to connect external debuggers for debugging when the
interface MCU USB cable is not connected or the DK is in nRF only mode.
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Figure 25: Debug input and trace connectors

For trace, a footprint for a 20-pin connector is available (P25). If trace functionality is required, it is
possible to mount a 2x10 pin 1.27 mm pitch surface-mount pin header.

Some of the trace pins are by default used for other functionality on the DK. By sliding the TRACE switch

(SW7) from Def. to Alt., the functionality is moved to other GPIOs. See the following table for more
information.

GPIO Trace Default use Optional GPIO
P0.07 TRACECLK UART CTS P0.04

P1.00 TRACEDATA[O]

PO.11 TRACEDATA[1] Button 1 P1.07

P0.12 TRACEDATA[2] Button 2 P1.08

P1.09 TRACEDATA[3]

Table 5: Default and Trace GPIOs

The reference voltage for the debug input and trace is by default connected to VDD_nRF'. This can be
connected to the VDD by cutting SB60 and soldering SB59.

8.9 Debug output

The nRF52833 DK supports programming and debugging external boards with nRF51 Series or nRF52
Series SoCs. To debug an external board with SEGGER J-Link OB IF, connect to the Debug out connector
(P19) with a 10-pin cable.
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Figure 26: Debug output connector

When the external board is powered, the interface MCU will detect the supply voltage of the board and
program/debug the target chip on the external board instead of the onboard nRF52833 SoC.

Note: The voltage supported by external debugging/programming is VDD voltage. Normally, this
is 3 V when running from USB, but if the onboard nRF52833 SoC is supplied from either USB or Li-
lon, the nRF power source switch (SW9) is in either Li-Po or USB position, and VDD can be set by
the nRF52833 firmware. Make sure the voltage level of the external board matches the VDD of the
nRF52833 DK.

You can also use P20 as a debug out connection to program shield-mounted targets. For both P19 and
P20, the interface MCU will detect the supply voltage on the mounted shield and program/debug the
target.

If the interface MCU detects target power on both P19 and P20, it will by default program/debug the
target connected to P19.

If it is inconvenient to have a separate power supply on the external board, the nRF52833 DK can supply
power through the Debug out connector (P19). To enable this, short solder bridge SB47. While SB47 is
shorted, it is not possible to program the onboard nRF52833 SoC even if the external board is unplugged.

8.10 Connectors for programming external boards

The voltage on the external board must match that of the DK.
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1 EXT_VTG Voltage supply from the external target,
used as voltage detect input to the interface
MCU

2 EXT_SWDIO Serial Wire Debug (SWD) data line

3 GND Ground

4 EXT_SWDCLK SWD clock line

5 GND Ground

6 EXT_SWO Serial Wire Output (SWO) line

7 N.C. Not used

8 N.C. Not used

9 EXT_GND_DETECT Ground detect. Should be connected to
ground on the external board

10 EXT_RESET Reset

Table 6: Pinout of connector P19 for programming external targets

I =

1

VDD_nRF Used for current measurement

2 VDD_nRF Used for current measurement

3 SH_VTG Voltage supply from the external target, used
as voltage detect input to the interface MCU

4 SH_SWDIO Serial Wire Debug (SWD) data line

5 SH_SWDCLK SWD clock line

6 SH_SWO Serial Wire Output (SWO) line

7 SH_RESET Reset line

8 SH_GND_DETECT Ground detect. Should be connected to
ground on the external board

9 VIN3-5V Voltage supply

9 VDD_HV Used for current measurement

10 VDD_HV’ Used for current measurement

12 VIO_REF GPIO voltage reference input

13 ID DK ID resistor

Table 7: Pinout of connector P20 for programming target on shields

8.11 NFC antenna interface

The nRF52833 DK supports an NFC tag.
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NFC-A listen mode operation is supported on the nRF52833 SoC. The NFC antenna input is available on
connector J5 on the nRF52833 DK.
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Figure 27: NFC antenna connector

NFC uses two pins, L24 (NFC1) and J24 (NFC2), to connect the antenna. These pins are shared with GPIOs
(P0.09 and P0.10) and the PROTECT field in the NFCPINS register in UICR defines the usage of these pins
and their protection level against abnormal voltages. The content of the NFCPINS register is reloaded at
every reset.

Note: The NFC pins are enabled by default.

NFC can be disabled and GPIOs enabled by defining the CONFIG_NFCT_PINS_AS_GPIOS variable in
the project settings. The way of doing this depends on the IDE/toolchain in use:

When using SEGGER Embedded Studio, select Project > Edit Options > Code > Preprocessor >
Preprocessor Definitions and add the CONFIG_NFCT_PINS_AS_GPIOS variable.

When using Keil, go to Project > Options for Target > C/C++ > Preprocessor Symbols > Define
and add the CONFIG_NFCT_PINS_AS_GPIOS variable.

Pins L24 and J24 are by default configured to use the NFC antenna, but if they are needed as normal
GPIOs, R44 and R46 must be NC and R43 and R45 must be shorted by OR.

IC46
PO.09NFCI R43 R44 300pF
P0.09 L] I NFC1

N.C. OR
R45 R46
P0.10 —— Y — NFC2
N.C. 0R
(POIONFC2
P0.10/NFC2 car

300pF

Figure 28: NFC input

8.12 Extra op-amp

The voltage follower for the power supply uses a dual package op-amp.

The extra op-amp has been routed out to a connector (P28, not mounted) so that it is accessible for the

user.

For more information on the power supply, see Power supply on page 16.
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Pin List 1x3
Not mounted

Ul19B
TS27L2IPT

Figure 29: Extra op-amp

8.13 Solder bridge configuration

The nRF52833 DK has a range of solder bridges for enabling or disabling functionality on the DK. Changes
to these are not needed for normal use of the DK.

The following table is a complete overview of the solder bridges on the nRF52833 DK.

Solderbridge Default Function

SB1 Closed Cut to disconnect the 32.768 kHz on P0.01

SB2 Closed Cut to disconnect the 32.768 kHz on P0.00

SB3 Open Short to enable P0.01 as normal GPIO

SB4 Open Short to enable P0.00 as normal GPIO

SB5 Closed Cut to disconnect LED1

SB6 Closed Cut to disconnect LED2

SB7 Closed Cut to disconnect LED3

SB8 Closed Cut to disconnect LED4

SB9 Open Short to bypass power switch

SB30 Open Short to reset the interface MCU

SB31 Open Short to bypass the USB detect switch

SB32 Open Short to permanently enable the 1’C pull-up resistors

SB33 Closed Cut to permanently disable the 1’C pull-up resistors

SB34 Open Short to bypass the power switch on the USB power

SB36 Open Short to bypass the power switch on the external supply power

SB37 Open Short to bypass the interface MCU power switch

SB38 Closed Cut to disable VDD power to the Arduino interface

SB39 Open Short to bypass the power switch for regulator, coin cell, or external
supply

SB40 Closed Cut for current measurements of the VDD_nRF

SB41 Closed Cut for current measurements of the VDD_nRF_HV

SB42 Closed Cut to disconnect IF Boot/Reset button from nRF52833 reset pin
when the interface MCU is disconnected

SB43 Open Short to connect IF Boot/Reset button to RESET pin on the Arduino
interface
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Solderbridge Default Function

SB44 Open Short to connect the RESET pin on the Arduino interface to the
nRF52833 reset pin

SB45 Open Short to connect the RESET pin on the Arduino interface to
the interface nRF52833 reset pin when the interface MCU is
disconnected

SB46 Open Short to connect the RESET pin on the Arduino interface to the
interface MCU Boot when the interface MCU is disconnected

SB47 Open Short to enable power supply of the external device when using the
debug out connector

SB48 Open Short to bypass the interface MCU USB power switch

SB49 Open Short to connect VDD_UTMI to VDD_SAM

SB50 Closed Cut to disconnect the nRF52833 CTS line from the signal switch and
interface MCU

SB51 Closed Cut to disconnect the nRF52833 RTS line from the signal switch and
interface MCU

SB52 Closed Cut to disconnect the nRF52833 RxD line from the signal switch and
the interface MCU

SB53 Closed Cut to disconnect the nRF52833 TxD line from the signal switch and
interface MCU

SB54 Closed Cut to disconnect the nRF52833 SWDIO line from the signal switch
and interface MCU

SB55 Closed Cut to disconnect the nRF52833 SWDCLK line from the signal switch
and interface MCU

SB56 Closed Cut to disconnect the nRF52833 RESET line from the signal switch
and interface MCU

SB57 Closed Cut to disconnect the nRF52833 SWO line from the signal switch and
the interface MCU

SB58 Closed Cut to disconnect voltage follower from external supply when SW10
is in ON position

SB59 Open Solder to connect debug in and trace reference voltage to VDD

SB60 Closed Cut to disconnect debug in and trace reference voltage from
VDD_nRF'

SB65 Closed Cut to disable the pull-up resistor of the IMCU_BOOT line

SB80 Open Short to bypass the power switch for the VBUS of nRF52833

SB81 Open Short to bypass the power switch for VDD_HV of nRF52833
Table 8: Solder bridge configuration
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9 Measuring current

The current drawn by the nRF52833 SoC can be monitored on the nRF52833 DK.
Current can be measured using various test instruments. Examples of test equipment are the following:

e Power analyzer

e Oscilloscope

e Ampere meter

e Power Profiler Kit

Power analyzer and Power Profiler Kit measurements are not described in this document. For more
information on Power Profiler Kit, see Power Profiler Kit User Guide.

For measuring instructions, see Using an oscilloscope for current profile measurement on page 38 and
Using an ampere meter for current measurement on page 39.

The nRF52833 SoC has two possible power supplies, VDD (1.7-3.6 V) and VDDH (2.5-5.5 V). The nRF52833
DK is prepared for measuring current on both domains. Only the VDD domain current measurement

is described here, but the approach is the same with the VDDH supply. See the following table for the
corresponding components.

Component VDD VDDH
Measurement connector P22 P23
Solder bridge SB40 SB41
Series resistor R90 R91

Table 9: Components for current measurement on VDD and VDDH

Note: When measuring the current consumption:

e Itis not recommended to use a USB connector to power the DK during current measurements
due to potential noise from the USB power supply. However, when measuring current on an
application using the USB interface of the nRF52833 SoC, the USB must be connected. It is
recommended to power the DK from a coin cell battery, external power supply on connector
P21 (1.7-3.6 V), or through the Li-Po connector J6 or P27 (2.5-5.0 V).

e The current measurements will become unreliable when a serial terminal is connected to the
virtual COM port.

e After programming the nRF52833 SoC, the USB for the interface MCU must be disconnected.

For more information on current measurement, see the tutorial Current measurement guide:
Introduction.

9.1 Preparing the DK

To measure current, you must first prepare the DK.

The suggested configurations actually split the power domains for the nRF52833 SoC and the rest of the
DK.
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Figure 30: Preparing the DK for current measurements

e To put P22 in series with the load, cut the PCB track shorting solder bridge SB40.

¢ To restore normal kit function after measurement, solder SB40 or apply a jumper on P22.

9.2 Using an oscilloscope for current profile

measurement

An oscilloscope can be used to measure both the average current over a given time interval and capture

the current profile.

Make sure you have prepared the DK as described in section Preparing the DK on page 37.

1. Mount a 10 Q resistor on the footprint for R90.

2. Connect an oscilloscope in differential mode or similar with two probes on the pins of the P22

connector as shown in the following figure.

3. Calculate or plot the instantaneous current from the voltage drop across the 10 Q resistor by taking the
difference of the voltages measured on the two probes. The voltage drop will be proportional to the
current. The 10 Q resistor will cause a 10 mV drop for each 1 mA drawn by the circuit being measured.

The plotted voltage drop can be used to calculate the current at a given point in time. The current can
then be averaged or integrated to analyze current and energy consumption over a period.
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Figure 31: Current measurement with an oscilloscope

Some tips to reduce noise:
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Measuring current

e Use probes with 1x attenuation
¢ Enable averaging mode to reduce random noise
¢ Enable high resolution function if available

Use a minimum of 200 kSa/s (one sample every 5 ps) to get the correct average current measurement.

9.3 Using an ampere meter for current measurement

The average current drawn by the nRF52833 SoC can be measured using an ampere meter. This method
monitors the current in series with the nRF device.

Make sure you have prepared the DK as described in section Preparing the DK on page 37.

Connect an ampere meter between the pins of connector P22 as shown in the following figure.
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Figure 32: Current measurement with an ampere meter

Note: An ampere meter will measure the average current drawn by the nRF52833 SoC if:

e The SoCis in a state where it draws a constant current, or, the activity on the device changing
load current, like BLE connection events, is repeated continuously and has a short cycle time
(less than 100 ms) so that the ampere meter will average whole load cycles and not parts of the
cycle.

e The dynamic range of the ampere meter is wide enough to give accurate measurements from 1
HA to 15 mA.

We recommend that you use a true RMS ampere meter.
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O RF measurements

The nRF52833 DK is equipped with a small coaxial connector (J1) for conducting measurements of the RF
signal using a spectrum analyzer.

The connector is of SWF type (Murata part no. MM8130-2600) with an internal switch. By default, when
no cable is attached, the RF signal is routed to the onboard trace antenna.

A test probe is available (Murata part no. MXHS83QE3000) with a standard SMA connection on the other
end for connecting instruments (the test probe is not included with the kit). When connecting the test
probe, the internal switch in the SWF connector will disconnect the onboard antenna and connect the RF
signal from the nRF52833 SoC to the test probe.
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Figure 33: Connecting a spectrum analyzer

NRF52833-DK

The connector and test probe will add loss to the RF signal, which should be taken into account when
measuring. See the following table for more information.

Frequency (MHz) Loss (dB)
2440 1.0
4880 1.7
7320 2.6
Table 10: Typical loss in connector and test probe
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Glossary

Clear to Send (CTS)

In flow control, the receiving end is ready and telling the far end to start sending.

Data Terminal Ready (DTR)

A control signal in RS$-232 serial communications transmitted from data terminal equipment, such as
a computer, to data communications equipment.

Development Kit (DK)

A development platform used for application development.

Hardware Flow Control (HWFC)

A handshaking mechanism used to prevent an overflow of bytes in modem:s. It is utilizing two
dedicated pins on the RS-232 connector, Request to Send and Clear to Send.

Integrated Development Environment (IDE)

A software application that provides facilities for software development.

Mass Storage Device (MSD)

Any storage device that makes it possible to store and port large amounts of data in a permanent
and machine-readable fashion.

Near Field Communication (NFC)

A standards-based short-range wireless connectivity technology that enables two electronic devices
to establish communication by bringing them close to each other.

NFC-A Listen Mode

Initial mode of an NFC Forum Device when it does not generate a carrier. The device listens for the
remote field of another device. See Near Field Communication (NFC) on page 41.

Operational Amplifier (op-amp)

A high-gain voltage amplifier that has a differential input and, usually, a single output.

Receive Data (RXD)

A signal line in a serial interface that receives data from another device.

Request to Send (RTS)

In flow control, the transmitting end is ready and requesting the far end for a permission to transfer
data.

Root Mean Square (RMS)

An RMS meter calculates the equivalent direct current (DC) value of an alternating current (AC)
waveform. A true-RMS meter can accurately measure both pure waves and the more complex
nonsinusoidal waves.

SubMiniature Version A (SMA) Connector
A semi-precision coaxial RF connector for coaxial cables with a screw-type coupling mechanism.
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System on Chip (SoC)

A microchip that integrates all the necessary electronic circuits and components of a computer or
other electronic systems on a single integrated circuit.

Transmit Data (TXD)

A signal line in a serial interface that transmits data to another device.

Universal Asynchronous Receiver/Transmitter (UART)

A hardware device for asynchronous serial communication between devices.
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Acronyms and abbreviations

These acronyms and abbreviations are used in this document.

CTS
Clear to Send

DK
Development Kit

DTR
Data Terminal Ready

HWFC
Hardware Flow Control

IDE
Integrated Development Environment

MSD
Mass Storage Device

NFC
Near Field Communication

op-amp
Operational Amplifier

RMS
Root Mean Square

RTS
Request to Send

RXD
Receive Data

SMA
SubMiniature version A

SoC
System on Chip

TXD
Transmit Data

UART
Universal Asynchronous Receiver/Transmitter
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Recommended reading

In addition to the information in this document, you may need to consult other documents.

Nordic documentation

e nRF52833 DK Getting Started

¢ nRF52833 Product Specification
¢ Software Development Kit

¢ nRF52833 Compatibility Matrix
e nRF52833 Engineering A Errata
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https://www.nordicsemi.com/Software-and-Tools/Development-Kits/nRF52833-DK/GetStarted#infotabs
https://infocenter.nordicsemi.com/topic/ps_nrf52833/keyfeatures_html5.html
https://infocenter.nordicsemi.com/topic/struct_sdk/struct/sdk.html
https://infocenter.nordicsemi.com/topic/comp_matrix_nrf52833/COMP/nrf52833/nrf52833_comp_matrix.html
https://infocenter.nordicsemi.com/topic/errata_nRF52833_EngA/ERR/nRF52833/EngineeringA/latest/err_833.html

Legal notices

By using this documentation you agree to our terms and conditions of use. Nordic Semiconductor may
change these terms and conditions at any time without notice.

Liability disclaimer

Nordic Semiconductor ASA reserves the right to make changes without further notice to the product to
improve reliability, function, or design. Nordic Semiconductor ASA does not assume any liability arising out
of the application or use of any product or circuits described herein.

Nordic Semiconductor ASA does not give any representations or warranties, expressed or implied, as to
the accuracy or completeness of such information and shall have no liability for the consequences of use
of such information. If there are any discrepancies, ambiguities or conflicts in Nordic Semiconductor’s
documentation, the Product Specification prevails.

Nordic Semiconductor ASA reserves the right to make corrections, enhancements, and other changes to
this document without notice.

Life support applications

Nordic Semiconductor products are not designed for use in life support appliances, devices, or systems
where malfunction of these products can reasonably be expected to result in personal injury.

Nordic Semiconductor ASA customers using or selling these products for use in such applications do so
at their own risk and agree to fully indemnify Nordic Semiconductor ASA for any damages resulting from
such improper use or sale.

RoHS and REACH statement

Complete hazardous substance reports, material composition reports and latest version of Nordic's REACH
statement can be found on our website www.nordicsemi.com.

Trademarks

All trademarks, service marks, trade names, product names, and logos appearing in this documentation
are the property of their respective owners.

Copyright notice

© 2020 Nordic Semiconductor ASA. All rights are reserved. Reproduction in whole or in part is prohibited
without the prior written permission of the copyright holder.
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